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In this section:

■■ Understanding what slide layouts and 
themes control

■■ Applying a layout

■■ Working with themes

■■ Changing theme colors and fonts

■■ Changing slide backgrounds and sizes

Adjusting slide 
appearance 9
A presentation has to have solid content and clearly fleshed-out topics, 

but it must also hold your audience’s attention. Visual enhancements 
such as color, font styles, and graphics go a long way toward impressing 
your audience through your professional approach.

For Microsoft PowerPoint 2013, you now have several built-in design ele-
ments that you can use for your presentations. These design elements, 
including slide layouts, themes, theme colors, and theme fonts, offer an 
inherent consistency that comes as a result of a common look and feel. 
This consistency means that you don’t have to be a graphic designer to 
prepare an attractive presentation.

Layouts control how many and what types of placeholders appear on a 
slide. For example, a layout might contain only a slide title placeholder, or 
a slide title plus content placeholders. Themes can be applied to individual 
slides or to multiple slides in your presentation. A theme includes back-
ground colors, graphics, font styles and sizes, and alignment of placehold-
ers and text. Theme colors are preset combinations of colors for your slide 
backgrounds, text, and graphic elements, whereas theme fonts are preset 
heading and body font combinations. You can further customize the look 
of a presentation by changing slide backgrounds and slide size.



Understanding what slide layouts and themes control
Slide layouts provide a basic structure to your slides by 
including placeholders that can contain title or subtitle text, 
bulleted lists, or different kinds of graphic elements (referred 
to as content) in a variety of combinations. By selecting 
the right slide layout, you make the job of adding text and 
content easier because placeholders make building slides 
automatic.

Whereas slide layouts control the types of slide content, slide 
themes apply the design elements of a slide. These include a 
background color, fonts and colors used for various items in 
the presentation, and effects such as gradients. In addition, 
each of the built-in themes includes color variants that you 
can use to change the background color and the colors for 
other objects such as text.

Layout gallery

Slide content 
placeholder 
containing text

Slide content placeholder 
ready for text or graphic 
content

Slide title placeholder 
containing text (main topic)

Background colorGraphic element

Theme 
gallery

Variants
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Apply a different layout to a slide
1	 Display the slide whose layout you want to change and then, on the 

ribbon, click the Home tab.

2	 In the Slides group, click Layout to open the Layout gallery.

3	 Click a layout to apply it. 

Applying a layout
A slide layout in PowerPoint is like a blueprint for a house; it 
establishes the various types of “rooms” that appear on your 
slide. Just as certain types of rooms contain certain types of 
furniture, slides can contain different types of objects. A Title 

And Content slide holds a title and bullet list, whereas a Picture 
With Caption slide holds an image and some text that describes 
it. The placeholders in a layout automatically format the content 
you add, applying settings specific to each type of placeholder.

1 32

TRY THIS  You can determine a slide’s layout when you first 
create it. Click the Home tab and then, in the Slides group, click 

the down-arrow on the New Slide button. Click the layout you prefer, 
and the slide is created with that layout applied.

TIP  In PowerPoint 2013, layouts with content now include 
both bulleted text and graphic/multimedia content tools within 

each content placeholder. You must pick one type of content to add to 
each placeholder. When you use the tool to add one type of content to 
a placeholder, the other tools disappear.

This slide’s layout uses 
a title placeholder and 
a content placeholder

Applying a layout: Apply a different layout to a slide  119
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Working with themes
Themes in PowerPoint provide a suite of design settings and 
style definitions that give your slides a consistent look and 
feel. You can apply a theme in a single action, putting in place 
background graphics, colors, fonts, and effects. The gallery 

of themes located on the Design tab helps you preview and 
choose the best look for your presentation. You can further 
adjust the look of a presentation by choosing another color 
combination in the Variants group. 

Change the theme
1	 On the ribbon, click the Design tab.

2	 In the Themes group, click the More arrow in the Themes gallery. 

3	 Move your mouse pointer over a theme to see a preview of it 
applied on your slides.

4	 Right-click a theme. On the shortcut menu that opens, click one of 
two options:

•	 Choose Apply To All Slides to apply the theme to every slide in 
your presentation.

•	 Choose Apply To Selected Slides to apply the theme only to the 
currently selected slide or slides.

(continued on next page)

1 2

SEE ALSO  For information about making individual changes to 
design elements on slides, see Section 11, “Formatting text and 

objects,” starting on page 165.

4

3
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Change the theme  (continued)

5	 In the Variants group, move your mouse pointer over a thumbnail 
to see a preview of its colors applied to the current slide.

6	 Click the variant thumbnail to apply the colors to the slide.

TIP  If you want to apply a theme to several slides, it’s easiest 
to display Slide Sorter view, click the first slide to which you 

want to apply the theme, and then hold down the Ctrl key and click 
other slides. Follow the preceding task steps to apply the theme and 
variant to the selected slides.

SEE ALSO  When you apply a new theme, that process creates 
a master. For more information about working with slide 

masters, see “Understanding how slide masters work” on page 66.

65
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Select a different theme color scheme
1	 On the ribbon, click the Design tab.

2	 In the Variants group, click the More arrow in the Variants gallery.

3	 On the menu that appears, point to Colors.

4	 In the gallery that opens, click a color scheme to apply it to all 
slides. Or, you can right-click a color scheme and choose Apply To 
Selected Slides.

Changing theme colors and fonts
Themes include settings for colors and fonts. A theme’s color 
scheme affects most elements on your slide, including back-
ground, text, and graphics. Theme colors provide sets of colors 
that work well together, so the slides within your presentation 
maintain not only an attractive look, but a cohesive one, as well. 

Theme fonts include settings for heading and body fonts. When 
you apply a theme, it contains a preset color scheme and fonts, 
but you can change the theme colors and theme fonts to give 
your slides a different look. 

1 2

34

TIP  Be sure to use color combinations that work well in the 
space where you will give your presentation. Most color 

combinations PowerPoint offers should help to keep your text 
readable, but if you decide to change the color of an individual 
element yourself, remember that light text colors are hard to read in a 
lighted room. 

TIP  After you click the More button in the Variants group, you 
can use the Effects choice to display the gallery of theme 

effects. From here you can apply another choice to the presentation.
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Change theme fonts
1	 On the ribbon, click the Design tab.

2	 In the Variants group, click the More arrow in the Variants gallery.

3	 On the menu that appears, point to Fonts.

4	 In the gallery that opens, click a font style to apply it to all slides.

1 2

TRY THIS  To create your own theme font, in the theme fonts 
gallery, choose Customize Fonts. Select a heading font and 

body font, give the theme font a name, and then click Save. The theme 
is now available in the Fonts gallery.

TIP  After you change the theme colors and fonts, you can 
save your changes as a new, custom theme. In the Themes 

group, click the More button, click Save Current Theme, enter a name, 
and then click Save.

4 3
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Change the background color and hide 
graphics
1	 On the ribbon, click the Design tab.

2	 In the Customize group, click the Format Background button.

The Format Background pane opens.

3	 Select the Hide Background Graphics check box.

4	 Click Solid Fill.

5	 Click the Fill Color button and then click a color in the palette.

6	 To use the color on all slides, click Apply To All. 

7	 Click the pane Close (X) button. 

Changing slide backgrounds and sizes
In addition to theme settings, the slide background and size set-
tings impact the overall appearance of a presentation. You can 
change the background for the current slide or for all slides in 
the presentation. You also can hide background graphics if they 

interfere with other graphics or content placeholders you’ve 
placed on a slide. Choose the slide size that best fits the monitor 
on which you intend to display your presentation. 

1 2

4

3

6

5

7

TIP  You can use the other choices in the Fill section in the 
Format Background pane to create gradient, picture, texture, or 

pattern fills. 
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Change the slide size
1	 On the ribbon, click the Design tab.

2	 In the Customize group, click the Slide Size button.

The available slide sizes appear. 

3	 Click the slide size to use for your presentation.

Use the Standard (4:3) size for older displays, projection, or TV 
equipment.

A dialog box opens, asking how to scale slide content based on the 
new slide size.

4	 Click either Maximize or Ensure Fit.

The Maximize choice enlarges slide content to fill the slide size, and 
some content might be cut off; Ensure Fit reduces the size of slide 
content to fit on the new slide size. 

3

21

4
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Index
Numbers
3-D views of text,  146
4:3 (Standard) slide format,  19, 21, 125
16:9 (Widescreen) slide format,  19, 21

A
action buttons,  161, 162
Action Settings dialog box,  162
Add Chart Element drop-down list,  141
add-in programs, including,  15, 38
Add-Ins tab on ribbon,  14, 37
Adobe Reader,  259
advancing slides automatically,  218
alignment

of objects,  28
of placeholder contents,  95
of text in table cells,  132–133

alignment guides,  27
All Slides dialog box,  231
animation

applying custom to object,  200–201
modifying settings,  202–203
preview of,  206
removing effect,  203
reordering,  204
themes and,  66
turning off,  216
uses for,  193

Animation Painter,  205
Animation tab on ribbon

Advanced Animation group
Add Animation,  200

Animation pane,  202, 204
Preview,  206

annotations on slides,  233
color for,  216
saving,  59, 234, 235

antonyms,  210
Apply To All setting, for headers and 

footers,  243
Arrange button,  93
arrow pointer, changes to,  232
arrows, dashed-red, for relative widths,  28
audio

adding to transitions,  196
impact of transition speed,  197
inserting,  155–156
inserting online,  25–26

authenticating sender and recipient of email 
files,  271

AutoCorrect Options tool,  38
automatically advancing slides,  218
automatic playback of media file,  156
automatic timed-advance feature,  198
automatic update in header or footer

of current date,  243

B
background color, themes to control,  118
background graphics

changing,  70–72
omitting from handouts,  78
themes on,  66

background of slide,  124

Background Styles gallery, for handouts,  80
Backspace key,  89
Backstage view,  9, 12, 35, 36, 48

Close,  63
exiting,  36
Export tab, Package Presentation for 

CD,  222
File tab to display,  30, 31
Info tab

Check For Issues,  268
Protect Presentation,  270

Open tab, SkyDrive,  52
Options tab,  274
Print tab,  244, 246

Copies text box,  250
Settings section,  248

Save As tab,  60
Share tab,  224

Present Online,  33
Bing search

inserting images from,  143
for pictures,  22
royalty-free images and,  23
for video,  24, 157–158

blank presentation, opening (Ctrl+N),  48
BMP file format,  144
bold text,  39, 170
border

of shape, clearing,  174
of video,  190

bottom alignment of table text,  133
brightness of picture,  186–187
Bring Forward command,  184



276  Bring To Front command

Bring To Front command,  93, 184
browsing drives and folders,  51
bulleted lists,  82

alignment,  95
bullet points, in content placeholder,  98
bullets,  84

levels of,  101

C
CD, saving presentation to,  222
cells in tables, merging,  134
center alignment of table text,  133
centered text,  95
Character Spacing,  170
charms, displaying,  10
charts,  136–141

changing style and layout,  139–140
changing type,  137
displaying or hiding legend,  141
inserting,  136–138
inserting in slide master,  70
online pictures in,  142–143
types,  136

Chart Tools|Design contextual tab
Chart Layouts group

Add Chart Element,  141
Quick Layout,  139

Type group, Change Chart Type,  137
Choose A SmartArt Graphic dialog 

box,  149–150
clearing timings,  219
clip art.  See graphics
closing

online presentation,  257
panes,  37
presentations,  63
Slide Master view,  67
slide show,  59

Thumbnails pane,  56
cloud,  30–31

saving presentations to,  252–253
collapsing

outlines,  102
sections,  114
Thumbnails pane,  16

collating multiple printed copies,  250
color

for annotations,  216
changing in pictures,  188
Eyedropper tool for copying,  173
for object fill,  171
for Pen tool,  232
of text,  168–169
themes to control,  118, 122

Color gallery,  188
color scheme, themes and,  66
Colors dialog box,  169

for pen annotations,  216
columns in tables

deleting,  135
inserting,  130

commands, adding to ribbon,  272–273
comments,  212–214

adding,  212–213
Comments pane,  19–20

opening,  214
Comparison slide layout,  129
computers without PowerPoint, running slide 

show from,  222
contextual tabs on ribbon,  6, 12, 14, 36, 37
contextual toolbars,  2
contiguous slides selection

for copying,  110
for hiding,  112

continuous loop for video playback,  191
continuous sound for transition,  196
contrast of picture,  186–187

copying
with Animation Painter,  205
slides in Slide Sorter view,  110
text,  85

Copy To Folder dialog box,  223
corrections to text,  91–92
Creative Commons licensing,  143
cropping pictures,  154, 176
Ctrl key

for selecting multiple objects,  181
currency symbol, Euro (€),  86
current date, automatic update,  88

in header or footer,  243
customizing ribbon,  272–274
Custom Layout slide,  69
Custom Shows dialog box,  227, 265
custom slide shows,  261

creating,  265–267
running,  267
starting,  227

cutting text,  85

D
dashed-gray vertical lines,  28
dashed-red horizontal lines,  28
data entry.  See also text
date

automatic update,  86
in header or footer,  243
inserting,  88
preformatted,  86

Date And Time dialog box,  88
default settings

for printer,  246
restoring Quick Access toolbar to,  41
for ribbon,  14

restoring,  273
Define Custom Show dialog box,  265
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deleting
animation effects,  203
annotations on slides,  234
comments,  214
footer placeholder boxes,  68
hidden data with Document 

Inspector,  268
layouts,  74
objects,  177
saved annotations,  235
sections,  115
slide masters,  76
slides, in Slide Sorter view,  109
table rows or columns,  135
text,  89
tools from ribbon,  274

demoting outline text,  101
Design tab on ribbon

Customize group,  21
Format Background,  124
Slide Size button,  125

Themes group, Themes gallery,  44, 49, 120
Variants group,  27

Variants gallery,  44, 122, 123
desktop taskbar (Windows),  10
diagramming, SmartArt for,  149–151
dialog boxes,  12, 36

launcher,  36, 37
opening,  14

digital signature,  261, 270–271
display equipment, testing,  226
displaying

comments,  214
hidden slides,  231
slide masters,  67
Thumbnails pane,  56

divider for pane, dragging,  55
Document Inspector,  261, 268–269
double-sided printing,  250

Drawing Tools|Format contextual tab on 
ribbon,  6, 15, 38, 42, 163, 183–184

Arrange, Group Objects,  182
Insert Shapes group, Merge Shapes,  185
Picture Styles group

Picture Border,  173
Picture Effects,  174–175

Shape Fill button,  96
WordArt Styles group, Text 

Effects,  147–148
drives

browsing,  51
for saving presentation,  61

drop-down gallery,  6
duplicating slides, in Slide Sorter view,  111
duration

of animation,  203
of transition,  197

E
editing text,  89
Edit Photo Album dialog box,  160
Effect Options dialog box, for 

animation,  202–203
email

authenticating sender and recipient of 
files,  271

presentation as attachment,  259
for sending presentations,  213, 224

email addresses
for sharing files,  254
for sharing online presentation link,  256

End Of Slide Show message,  54
Ensure Fit option for scaling slide content,  21, 

125
erasing annotations on slides,  234
Esc (Escape) key, to end slide show,  59
Euro (€) currency symbol,  86

exiting
Backstage view,  36
Reading view,  54

expanding
outlines,  102
Thumbnails pane,  16

Export options,  258
Export tab, Create A Video,  260
Eyedropper tool,  173

F
feedback from reviewers,  212
File Explorer, copying PowerPoint tile 

from,  10
file formats

for saving presentation,  61, 258
specifying for file list,  51

file-management commands,  35
File tab on ribbon,  9, 12, 35, 36

Export tab,  61
Create PDF/XPS Document,  258

for displaying Backstage view,  30
Info, Show All Properties,  269
Open, Places, Recent Presentations,  51
Options, Proofing, Hide Spelling 

Errors,  209
Print tab,  244
Save As,  252
Share,  213

Invite People,  254
Present Online,  255

fill
for objects, clearing,  172
for placeholder,  96

fill color for object,  171–172
finding existing presentation files,  50
Find Whole Words Only option, in Replace 

dialog box,  92



278  Fit Slide To Current Window button

Fit Slide To Current Window button,  55
Flickr,  22, 23
flipping objects,  180
folders

browsing,  51
opening,  51
for saving presentation,  61

Font dialog box
Character Spacing tab,  170

fonts,  166
finding additional to install,  166
formats in slide master,  68
in Outline pane or Slide pane,  99
for notes,  79
preview of,  43
themes to control,  66, 118, 122, 123
TrueType

including in saved file,  222
Font Size

changing,  39
previewing,  43

Font text box, in Symbol dialog box,  87
footers.  See headers and footers
Format Background pane,  72, 124
Format contextual tab on ribbon,  94
Format Picture pane,  96
Format Shape command,  96
Format Shape dialog box,  175
formatting.  See also themes

for printing slides,  248–249
object fill,  171–172
placeholders,  82, 95–96, 96
shapes,  38
text boxes,  163

formatting text,  166–172
color,  168–169
fonts,  166
mini toolbar for,  39

in Outline pane,  104
size changes,  167

fraction character,  86
frame around slides,  249
Full Page Slides, as print format option,  249
Full Screen mode,  5, 47, 53, 226

for video,  191

G
galleries,  6, 12, 35, 36, 42

of graphical selections,  9
Shapes,  161
Themes,  49

gallieries
Color,  188
Shapes,  15

GIF file format,  144
gradient for object fill,  171–172
graphics,  127–164.  See also background 

graphics; master graphics
appearing only on handouts,  77
charts,  136–141
hiding,  124
photo album for,  159–160
shapes,  161–162
in slide masters,  68, 70
in themes,  118

gray slash, as hidden slide marker,  112
grouping objects,  181–182

H
handles

for object rotation,  178
for resizing,  176

Handout Master contextual tab on ribbon
Background group, Hide Background 

Graphics,  78
Handout Orientation,  77

Page Setup group, Slides Per Page,  78
Slide Orientation,  77

handout masters,  77–78
handouts

Background Styles gallery for,  80
printing,  249

Header And Footer dialog box,  242
headers and footers

displaying information in,  242–243
inserting information,  68
removing placeholder boxes,  68, 69

Help,  45
hidden data, Document Inspector to 

remove,  268
hiding

chart legend,  141
comments,  214
graphics,  124
slides,  107, 109, 112
subheads in outline,  102

Home tab on ribbon
Arrange button,  93, 133
Bring to Front button,  93
Clipboard group

Copy,  85, 110
Cut,  85, 177
Paste,  85, 110, 177

Drawing group, Arrange,  180
Editing group

Replace,  91
Select,  93

Font group,  43, 166
for font attributes,  170
Font Color,  168
Font Size,  167

Paragraph group
alignment buttons,  95
Bullets button,  84
Increase List Level,  101
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Send To Back button,  93
Slides group,  105

New Slide,  83, 119
Section, Add Section,  114

horizontal flip of object,  180
horizontal lines, dashed-red, as Smart 

Guides,  28
horizontal option for printing multiple 

slides,  249

I
icons

display for audio clip,  25
in SmartArt styles,  151

Illustrations group on Insert tab,  15
Shapes button,  38

importing from Microsoft Word document
outline,  97
text,  104

Increase List Level option,  101
Information Rights Management Service,  271
ink technology,  232–233
Insert Audio window,  26
Insert Chart dialog box,  137
inserting

charts,  136–138
date and time,  88
footer information,  68
local media objects,  155–156
pictures

from files,  152
online,  22–23, 142–143
from SkyDrive,  144–145

slide masters,  75
slides,  83
SmartArt,  149–150
table rows and columns,  130
tables,  128–129

themes,  75
video from online,  25, 157–158
Word outline,  105

Insert New Pictures dialog box,  159
Insert Outline dialog box,  105
Insert Picture dialog box,  142, 144

for SmartArt,  151
Insert Shapes group,  29
Insert tab on ribbon,  70

Illustrations group,  15, 38
Shapes,  161

Images group
Online Pictures,  22
Photo Album,  159

Media group,  24, 25
Audio,  155
Video,  155

Shapes gallery,  42
Symbols group,  86
Text group

Date & Time,  88
Header & Footer button,  242
Text Box,  163
WordArt,  146

Insert Video window,  24
italic text,  39, 170

J
JPEG file format,  144

K
kerning,  170
Keyboard, On-Screen,  13
keyboard shortcuts,  2

Alt+F5 for Presenter view,  32
Ctrl+F1 to control ribbon display,  18
Ctrl+N for new, blank presentation,  105
for cut, copy, and paste,  110

ScreenTip for displaying,  14, 37
kiosk, slide show set up for running at,  215

L
Landscape orientation

for notes master,  79
for slide or handout,  77

language, for Thesaurus,  211
Laser Pointer Color drop-down palette,  216
launching PowerPoint 2013,  10–11
Layout gallery,  118
layouts,  117

adding to Slide Master view,  69
applying,  119
components controlled by,  118
selecting for new slide,  119

left alignment of table text,  133
legend for charts, displaying or hiding,  141
licensing,  23
lines, wavy colored, from spelling check,  209
linked files, including in saved file,  222
link for online presentation, sending,  256
Live Preview feature,  42
Loop Continuously Until ‘Esc’ option,  216
Loop Until Next Sound option,  196
Lync application in Office,  255

M
Magnifying Glass,  228, 229
Manually Advance slides option,  218
Master Layout thumbnail,  70
masters.  See slide masters
Match Case option, in Replace dialog box,  92
Maximize option for scaling slide content,  21, 

125
Menu control,  228
menus,  2, 9, 12
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merging
cells in tables,  134
objects,  185
shapes,  29

microphone for narration,  219, 220
Microsoft Account,  12, 30, 36
Microsoft Office 2013 folder,  10
Microsoft Typography website,  166
Microsoft Word document

importing outline from,  97
importing text from,  104
inserting outline into PowerPoint,  105

Mini toolbar,  39, 89
monitors

multiple for Presenter View,  218, 236
resolution, impact on performance,  217

Motion Path category of animations,  200, 
201

mouse click, for slide advancement,  198
moving

between open presentation files,  85
objects,  28
slides

in Slide Sorter view,  111
or text in outline,  103

among views,  53
multimedia objects,  155–156
multiple shapes

selecting,  29

N
names

for presentations,  61
for sections,  114

changing,  115
of slide layouts,  73

narrations
adding,  219–220

running slide show without,  216
saving timings for,  219

navigating among views
Print Preview,  245
slide masters,  67
slide shows,  230–231
slides in Normal view,  108

navigation pane,  51
New Slide button,  105
New tab on ribbon,  48, 49
New window,  48, 49
Next control,  228
next slide, moving to,  230
noncontiguous slides selection

for copying,  110
for hiding,  112

Normal view,  47, 53, 82
navigating slides in,  108
new features,  16–17
Outline view vs.,  97
sizing panes in,  55–56
Thumbnails pane,  107, 128

Notes And Handouts tab in Header and 
Footer dialog box,  243

notes master,  79–80
Notes Page,  53
Notes pane,  16, 55
numbers for slides, in header or footer,  243

O
objects

applying custom animation,  200–201
attaching comment to,  212
changing order,  183–184
clearing fill,  172
deleting,  177
flipping,  180
formatting fill,  171–172

grouping and ungrouping,  181–182
merging,  185
moving,  28
multimedia,  155–156
resizing,  176
rotating,  178–179
selecting multiple, Ctrl key for,  181

Office.com
Clip Art collection,  22, 142

audio clips in,  26
search box,  22

Help from,  45
Office Presentation Service,  255
Office Theme gallery,  83
On Click playback of media file,  156
online pictures

inserting,  22–23
photo services,  22

online templates,  48
On-Screen Keyboard,  13
Open dialog box (Ctrl+O),  48, 51
opening

blank presentation,  48
existing presentation,  50–51
folders,  51

Open tab on ribbon,  50
options.  See PowerPoint Options dialog box
order of animation, changing,  204
order of objects, changing,  183–184
organizational charts, photos in,  151
orientation for printing,  247
outline of shapes,  173–174

clearing,  174
Outline pane,  17

adding text,  100–101
mini toolbar,  101
text formatting in,  104
text size in,  99
text zoom in,  98
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outlines
expanding and collapsing,  102
importing from Microsoft Word 

document,  97
moving slides or text in,  103
relationship to slides,  98
text in, promoting and demoting,  101
text in shapes not included,  161
viewing and rearranging 

contents,  102–103
working with,  99

Outline tab on ribbon,  82
Outline view,  97

adding slide title,  100
displaying,  99
editing text in,  89

P
Package For CD dialog box,  222
panes,  9

closing,  37
in Normal view, sizing,  55–56

paper size for printing,  247
Paragraph group in Home tab

Increase List Level,  101
Paste button (Ctrl+V),  37
Paste Options button,  85
pasting

slides, in Slide Sorter view,  110
text,  85

PDF (Portable Document Format) document, 
saving slide show as,  61, 224, 258–259

Pen control,  228
Color list,  131, 216

Pen Weight drop-down list,  131
performance, monitor resolution impact 

on,  217
photo album,  159–160

Picture Border gallery,  173
pictures

brightness or contrast 
adjustments,  186–187

cropping,  154
file formats for,  144
as fill,  172
inserting

from file,  152
from online,  22–23, 142
from SkyDrive,  144–145
in slide master,  70

recoloring,  188
resizing,  154
use of local,  152–153

Picture Tools|Format contextual tab,  22, 142, 
183–184

Adjust group
Color,  188
Corrections,  186

Arrange
Bring Forward,  184
Bring to Front,  93, 184
Group Objects,  182
Send Backward,  184
Send to Back,  93, 184

Picture Styles group
Picture Border,  173
Picture Effects,  174–175

Size group, Crop,  154
Picture With Caption slide layout,  119
Pinch gesture,  7, 13
Pin To Taskbar,  10
placeholders,  3, 117, 118

adding special content,  86–88
adding to layout,  69
alignment of contents,  95
attaching comment to,  212
changing on handout master,  77

for date and time,  88
for footers,  68
formatting,  82, 95–96, 96
inserting table in,  128–129
in layout,  119
on notes masters,  79
selecting,  93–94
on slide layouts,  98
for text,  82, 84
themes for placement and size,  66
on title slide,  83

playback controls
for audio,  26
for video,  24

PNG file format,  144
portable media, saving slide show 

to,  222–223
portrait orientation

for notes master,  79
for slide or handout,  77

potx file format,  262
PowerPoint

Add-Ins tab for extras,  14
inserting Word outline into,  105
launching,  10–11
Microsoft account for,  36
new 2013 features,  6
screen layout,  9
user interface,  2, 3

PowerPoint Options dialog box,  36, 272–273
Add-Ins tab,  15, 38
Customize Ribbon,  274
Embedded TrueType Fonts option,  222
General tab,  14

ScreenTip style drop-down list,  37
Quick Access Toolbar,  40–41

PowerPoint Web App,  222
pptx file format,  61
practicing.  See rehearsing
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preformatted date,  86
presentations.  See also slide shows

saving to cloud,  252–253
sharing,  251–260

Presenter view,  32, 236–237
controls,  237

Present Online feature,  33, 255–258
practicing,  256
running and closing,  257

preview
of animation,  206
of mutlimedia file,  156
of transition,  194
of transition,  199

Previous control,  228
previous slide, moving to,  230
printing,  241–250

handouts,  77–78, 249
help topic,  45
including hidden slides,  112
number of copies for,  250
one- or two-sided,  250
printer and paper settings,  246

Print Preview,  244–245
navigating,  245

programs, switching between,  238
promoting

outline text,  101
proofing,  208
Proofing group on Review tab,  14–15, 37
proofreading,  54, 207
Properties dialog box

for printer,  246–247
Publish As PDF Or XPS dialog box,  258–259

Q
Quick Access toolbar,  12, 36, 38

adding tool,  15
customizing,  40–41
Redo [Action] button,  90
resetting to default,  41
Save button (Ctrl+S),  61, 63
Undo [Action] button,  90

Quick Layout gallery for charts,  139

R
readability,  168
Reading view,  47, 53, 54
Recording toolbar,  220
Record Slide Show dialog box,  219
red-green-blue (RGB) color system,  169
Redo command,  90

on Quick Access toolbar,  40
red wavy underline,  92
reflection, adding to object,  175
rehearsing,  207

online presentation,  256
saving timings,  221
slide shows,  219–220

remote viewers
live presentation to,  255–258
presentation to,  32

removing.  See also deleting
tools from ribbon,  274
transitions,  194

Replace dialog box,  91
Require User To Sign-In Before Accessing 

Documents check box,  31
Research pane,  14, 37
Research tab on ribbon

Proofing group,  37

resizing
handles for,  176
pictures,  154
WordArt,  146

resolution of monitor, impact on 
performance,  217

resume reading feature,  17
reviewers

comments,  19
feedback from,  212

Review tab on ribbon,  37
Comments group,  19, 214

New Comment,  212
Proofing group,  14–15

Spelling,  208
Thesaurus,  210

RGB (red-green-blue) color system,  169
ribbon,  3, 6, 12, 14–15, 35, 36

controlling display,  18
customizing,  272–274
removing or rearranging tools,  274
ScreenTips for tools on,  14
tools missing from,  38
using,  37–38

Ribbon Display Options button,  18
ribbon interface,  9
right alignment of table text,  133
rotating objects,  178–179
rows in tables

deleting,  135
inserting,  130

royalty-free pictures,  22
running presentation,  225–240

from computers without PowerPoint,  222
online,  257
in Slide Show view,  58–59
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S
Save As dialog box,  30, 60–61, 252, 260
Save As screen,  30, 252
Save command, on Quick Access toolbar,  40
saving

annotations,  59, 234, 235
presentations,  60–62

in other file formats,  258–259
to cloud,  252–253
to SkyDrive,  30, 62
to USB drive or CD/DVD,  222–223
as video,  260

rehearsal timings,  221
templates,  262–264
timings for narrations,  219

scaling slide content, to new slide size,  125
screen layout for PowerPoint 2013,  9
ScreenTips

displaying,  14
for tools on ribbon,  37

scroll bar, in Thumbnails pane,  108
Search charm,  10
Search, for Help,  45
Search Online Templates And Themes text 

box,  49
Section Header layout,  82
sections,  107, 114–115

renaming or deleting,  115
summary slides for large presentation,  227

security, for shared presentations,  31
selecting

multiple shapes,  29
placeholders,  93–94

Selection pane,  93, 94
self-running, full-screen presentation,  215
Send Backward command,  184
sending slide shows by email,  213, 224
Send To Back command,  93, 184

<Separator> item, on Quick Access 
toolbar,  41

Set As Default Printer option,  246
settings,  36.  See also PowerPoint Options 

dialog box
Set Up Show dialog box,  215, 216, 267

Advance Slides section,  218
Show Slides section,  217

shadow
adding to object,  175
for text,  170

Shape Fill gallery,  171
shapes

applying effect,  174–175
merging,  29
outlines of,  173–174
selecting multiple,  29

Shapes button,  38
Shapes gallery,  15, 161
sharing

images on SkyDrive,  145
presentations,  7, 251–260

as email attachment,  259
saving in other file formats for,  258–259
from SkyDrive,  31, 254

presentation template,  262
shortcut menus,  2
shortcuts.  See also keyboard shortcuts

for launching PowerPoint,  10
Show Presenter View option,  218
Show Without Animation option,  216
Show Without Narration option,  216
size changes

for text,  167
handles for,  176
panes in Normal view,  55–56
for pictures,  154
for slides,  125
for WordArt,  146

size of text, in Outline pane or Slide pane,  99
SkyDrive,  30, 52

inserting pictures from,  144–145
saving to,  62, 252–253
sharing images on,  145
sharing presentations from,  31, 254

slash, gray, as hidden slide marker,  112
Slide gesture,  7, 13
slide layouts

Comparison,  129
defined by themes,  66
deleting,  74
renaming,  73

slide masters,  65–80
background,  72
basics,  66
deleting,  76
displaying and navigating,  67
graphics

changing,  70–71
overlapping other slide content,  71

inserting,  75
making changes,  68–69

Slide Master tab on ribbon
Edit Master group,  66

Delete,  74
Insert Layout,  69
Insert Slide Master,  75
Rename,  73

Edit Theme tools,  66
Master Layout button,  69

Slide Master tools,  3
Slide Master view,  66, 67, 70–71

adding layouts,  69
applying custom animation in,  200
closing,  67
Thumbnails pane,  72, 73

Slide Navigator,  228
Slide pane,  55, 108
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text size in,  99
zoom slider for contents,  108

slides
adding,  83
advancing,  58, 198–199

in Reading view,  54
applying transition to,  194–195
building content,  84–85
deleting in Slide Sorter view,  109
hiding and unhiding,  107, 109, 112–113, 

231
listing sizes available,  21
moving in outline,  103
navigating

in Normal view,  108
to specific slide,  231

relationship of outline to,  98
selecting for printing,  248
specifying for inclusion,  217
viewing multiple,  57
writing on,  232–233

slide shows,  81–96
adding slide,  83
basics,  82
choosing type,  215
closing,  59, 63
consistency in look and feel,  65
creating,  47–64

custom,  265–267
from blank presentation,  48
opening template,  49
with theme,  48

custom,  261
ending,  59, 239
finding and opening existing,  50–52
jumping to previously viewed slide when 

opening,  17, 18
moving between open files,  85
navigating,  230–231

rehearsing,  207, 219–220
running,  32–33

from computers without 
PowerPoint,  222

custom,  267
in Slide Show view,  58–59

saving,  60–62
as template,  262–263
to SkyDrive,  62

sending by email,  213, 224
sharing,  7
sharing from SkyDrive,  31
slide content,  84–85
specifying slides for inclusion,  217
starting,  226–227
stopping,  267
transporting,  222–223

Slide Show tab on ribbon
From Beginning button,  58
Monitors group,  32

Use Presenter View,  236
Set Up group

Hide Slide,  112, 113
Record Slide Show button,  219
Rehearse Timings,  221
Set Up Slide Show,  215, 216, 217, 218

Slide Sorter button,  57
Start Slide Show group

Custom Slide Show,  227, 265, 267
From Beginning,  236

Slide Show tools,  4
Magnifying Glass,  229
Pen tool,  232–233
Slide Navigator button,  231

Slide Show view,  53, 226, 230
controls,  228–235

Menu control,  228
Esc key to end presentation,  239
running presentation in,  58–59

Slide Sorter view,  47, 53, 57
copying and pasting slides,  110
deleting slides in,  109
duplicating and moving slides,  111
for applying theme to multiple slides,  121
sections displayed in,  107
text formatting display,  104

slides per page, on handout,  78, 249
Slide tab in Header and Footer dialog 

box,  243
slide title,  100
Slide title placeholder,  118
SmartArt,  149–151
Smart Guides,  27, 28
sound.  See audio
spacing for text characters,  170
speaker notes,  16, 55

on Presenter view,  236
speed of transitions, modifying,  197
spelling check,  207, 208–209

stopping,  209
Spelling pane,  208
splitting cells of table column,  130
splitting merged table cells,  134
Standard (4:3) slide format,  19, 21, 125
Start button in Windows 7,  11
Start From Beginning command, on Quick 

Access toolbar,  40
starting presentation, in Presenter view,  236
Start Recording button,  219
Start screen, launching app on,  10
status bar

buttons for views,  53
Comments indicator,  214
Slide Show button,  226, 230
Slide Show view button,  58
Slide Sorter view button,  112

stopping
animation preview,  206
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narration recording,  220
slide show,  267
spelling check,  209

Stretch gesture,  7, 13
strikethrough text,  170
style for Pen tool,  232
styles, WordArt,  42
subheads, hiding in outline,  102
subtitle placeholders,  98
summary slides for large presentation,  227
Swipe gesture,  7, 13
switching between programs,  238
Symbol dialog box,  86–87
Symbol font,  87
synchronizing files

between cloud and hard drive,  252
in SkyDrive,  30, 62

synonyms,  210

T
Tab key, in SmartArt Text pane,  151
tables,  128–135

borders of,  131–132
deleting rows or columns,  135
inserting,  128–129
merging cells,  134
text alignment in cells,  132–133

Table Tools|Design tab on ribbon,  129
Draw Borders group,  131

Table Tools|Layout tab on ribbon,  129
Alignment group,  132–133
Merge group

Merge Cells,  134
Rows & Columns group,  130

Delete,  135
tablets,  7

touch gestures for,  13
tabs,  12

Tap gesture,  7, 13
taskbar (Windows)

displaying when show is running,  238
Touch Keyboard button,  13

templates
online,  48
opening,  49
saving,  262–264
using,  264
using in previous versions of 

PowerPoint,  263
testing display equipment,  226
text,  81.  See also formatting text

adding,  97
in Outline pane,  100
to placeholders,  84
to SmartArt,  150–151

alignment,  95
in table cells,  132–133

corrections to,  91–92
cutting, copying and pasting,  85
editing,  89
finding and replacing,  91–92
in outline

moving,  103
promoting and demoting,  101

size in Outline pane or Slide pane,  99
WordArt for,  146–148
zoom in Outline pane,  98

text boxes,  161
adding,  163
in slide master,  68

text placeholders,  98
texture for object fill,  171–172
theme color,  117, 172
theme fonts,  117
themes,  35, 117, 120–121, 165

applying another to layout,  72
color changes,  122

components controlled by,  118
design balance in,  95
inserting additional,  75
for new presentation,  48
slide layouts defined by,  66

Themes gallery,  44, 49
theme variants,  27
Thesaurus,  207, 210–211
third-party digital signature,  270
third-party programs, Add-Ins tab for,  14
Thumbnails pane in Normal view,  17, 55, 84, 

107, 108
closing and redisplaying,  56
collapsing and expanding,  16
cut, copy, and pasting slides,  111
sections displayed in,  107

thumbnails, Slide Sorter view for 
displaying,  57

TIFF file format,  144
time

in header or footer,  243
inserting,  88

timing
for animation,  203
for slide advance,  198, 218

automatic,  198
clearing,  219
saving from rehearsals,  221

Title And Content slide,  83, 100, 119
Title Only layouts,  82
title placeholders,  98

removing from layout,  69
Title slide layout,  4, 100

placeholders on,  83
Title Slide master,  76
toolbars,  2
tools on ribbon

adding,  273
removing,  274
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top alignment of table text,  133
touch gestures,  13
touchscreens,  7
transitions

adding sound,  196
applying,  194–197
applying effect,  199
applying to all slides,  195
modifying speed,  197
removing,  194
symbol indicating,  4

Transitions tab on ribbon,  195
Timing group

Duration,  197
On Mouse Click,  198
Sound,  196

Transition To This Slide,  194
Effect Options,  199

Transparent Color, setting,  188
transporting slide shows,  222–223
trimming video,  191
TrueType fonts, including in saved file,  222
typographical errors, correcting,  92

U
underlined text,  170

red wavy,  92
Undo command,  90

on Quick Access toolbar,  40
ungrouping objects,  181–182
unhiding slides,  107, 113, 231
USB flash drive, saving presentation to,  222
user interface,  35

V
Variants for themes,  118
Variants gallery on Design tab,  44
Variants group for themes,  121

vertical flip of object,  180
vertical lines, dashed-gray,  28
vertical option for printing multiple 

slides,  249
video,  189–191

inserting,  155–156
from online,  24–25, 157–158

playback settings,  191
saving presentation as,  258, 260

Video Tools|Format contextual tab on 
ribbon,  24

Adjust group
Color,  190
Corrections,  190

Preview group
Play,  158

Video Styles group,  189
Video Border,  190

Video Tools|Playback contextual tab on 
ribbon,  24

Editing group
Trim Video,  191

Video Options group
Start,  191

views, moving among,  53
View tab on ribbon,  53

Master Views group
Handout Master,  77
Notes Master,  79
Slide Master,  67

Outline View button,  99
Page Setup group, Notes Page 

Orientation,  79
Presentation Views group,  97

Reading View,  54
Slide Sorter,  109, 112, 114

Show group
Gridlines,  180
Notes,  16, 56

Window group, Switch Window,  85
visibility

of Help window,  45
of object on slide,  94

W
wavy colored lines, from spelling check,  209
Webdings font,  87
Whoosh sound effect,  196
Widescreen (16:9) slide format,  19, 21
Windows 7,  1

starting PowerPoint in,  11
Windows 8,  1

creating PowerPoint shortcut on 
desktop,  10

File Explorer,  10
Microsoft Account for,  12
starting PowerPoint from Start screen,  10
taskbar display,  238

Wind sound effect,  196
Wind transition,  196
Wingdings font,  87
Word.  See Microsoft Word
WordArt gallery,  4, 42
writing on slides,  232–233

X
XPS document, saving slide show as,  224

Y
YouTube, inserting video from,  24
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Z
zoom

to part of slide,  228
text in Outline pane,  98
to page, in Print Preview,  245
to part of slide,  229

Zoom slider
for Slide Master view,  67
for Slide pane contents,  108
for slide preview,  55
for Slide Sorter view,  57
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